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CS&T Corporate Time Calendar Client

Corporate Time is a calendar solution that allows you to create and share your
calendar and to schedule meetings for yourself or others who are using the same
calendar system. Using this system you can have the software check for conflicts,
find mutually acceptable meeting times for all involved and then send email about
the meeting.

How to get a Calendar Account
To use Corporate Time you must get an account on the campus calendar server.
Each Department/College will have a calendar coordinator (CC) who will request
that an account be set up on the calendar server by ACNS.  The CSU web page that
lists more information on the calendar system is at
http://www.colostate.edu/acns/calendar/  Anyone seeking a calendar account
must have an active Lamar account first.

After your account has been activated, either you or your system administrator will
need to install the client portion of the calendar software on your machine, unless
you intend to use the Web interface only.

Starting and Signing On
Individuals gain access to the system using their Lamar login-name and a password
that will be communicated by the CC in the individual’s department.  Your User
Name will be the same as your Lamar log-in name.  Once the individual has met
the requirements listed, the CC will initiate an add request and the individual will
be added to the system.
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Changing your Password
To change your password, from
either the In-Tray or Agenda
window, choose Options, Sign-In.
Enter your old password and then a
new one.  Note:  your Lamar and
Calendar passwords are not
synchronized.  Changing it in one
place does not automatically
change it in the other.

The In-Tray
Once you have logged in you will normally view the In-Tray first.  The In-Tray
window is the primary source for managing entries received or sent to others.  It
displays a list of folders that contain entries you have received, sent out, accepted
and refused.  By viewing the In-Tray you can quickly see any new entries since the
last Calendar session and can view details of an entry by double-clicking on the
item.

The In-tray’s New Entries folder displays entries (invitations) to which you have
not yet responded.  To view those entries, open the folder by clicking on the icon to
the left.  Double-click an Entry Title to open the View Entry dialog box. The
contents of the dialog box depend on the type of Entry you have selected.

Click an Entry’s icon to view a list of all the people and resources that have been
invited to the Entry. Next to each name is an icon indicating if and how the person
has replied to the Entry.

You can reply to an Entry by selecting and dragging it into the desired folder. Use
the Shift and Ctrl keys to select and move multiple Entries at once.

University Holidays
University holidays are set in advance and cannot be altered in your calendar.
Holidays for the year will appear in your In-Tray and will remain visible there
unless you place it in another folder or remove it from your agenda.  To remove it
from your agenda, right-click it and choose Remove from Agenda.   If you wish,
you could alternatively drag the item to a folder as described above.
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Responding to Invitations
By default, the setting "Can Invite Me To Events" under the Options, Access
Rights, Scheduling menu is checked.  That means, by default, anyone can invite
another calendar user to an event.

When you are invited to an event, an entry appears in your In-Tray as well as on
the appropriate day in your agenda.  To respond to an invitation, double click on the
event either from your In-Tray or from your agenda.  Choose from the following
options:  I will attend, I will not attend or I will confirm later.

Click anywhere on an Entry line with your right mouse button to reply to an Entry
without opening its dialog box. Once you have replied to an Entry, your Agenda will
put it in the appropriate In-tray folder (as an Entry you have either accepted or
refused).

To control how long an item remains in the In-Tray, go to Options, In-Tray and set
your preferences.

Opening an Agenda

To open an agenda,
press Ctrl-A, click the
button on the Toolbar,
or go to File, Open
Agenda.  This will
open your calendar for
the current day in Day
View with 8 a.m.
showing
at the top of the
display.  The Day View
shows scheduled
appointments for the
day as well as any uncompleted tasks, notes and daily events that you have entered.
Tasks, notes and events are all entered and edited via their own set of dialog boxes.

Other Views
In addition to the day view, you may wish to see either a weekly or monthly view.
To change the view of your calendar, from the View menu, choose View Day, View
Week, or View Month.  Or, click the corresponding button on the toolbar.  New
meetings can be scheduled from any view.  Tasks may only be viewed from the Day
View of the Agenda.  Notes may be view in either Day or Week Views.

Other options may be set in Day or Week View that modifies the size of the slots for
agenda items (View, Decrease and Increase Row Height) and that changes the
time range each slot represents (View, Decrease and Increase Row Time).  Note
that if you make the slots too narrow, no text will appear for an agenda item.    
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For any agenda item, you may see one or more of the following icons:
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Scheduling Meetings
To create a new event, choose one of the following:
1. Click in the time slot and type the event to be scheduled;
2. Double-click the time (this opens the New Meeting dialog box);
3. Highlight a range of time and double click on it to open the dialog box;
4. Click on the New Meeting button on the

toolbar.

[Note:  it is possible to double schedule events.  Any overlapping or simultaneous
events will be placed side by side in the calendar view.  The owner of the calendar
must then choose what to do about the conflict.]

New Meeting Dialog Box
When entering a new item,
you can add detail and/or
schedule the time through
the New Meeting dialog
box.

Date/Time
Select a title and location
and date for your meeting.
To see a calendar or time
control, click on the button to
the right of the date/time
space.  Using the graphical
controls, you can point and
click or drag to select dates or adjust the time.

People and Resources
To find a person, type their last name in the Add (People and Resources) box and
click on the green checkmark to search for them. To invite a group, click on the
button that displays a group of people and choose the appropriate group from the
list of displayed groups.

To use search criteria, click the magnifying glass to enter the search options.  You
can search by first name, last name, department, or location.  See search parameter
information in the table below.

Search Parameter Result
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Search by
Department in
Org Unit 1

Search by postal
address, e.g, 6FLS Univ

Enter any number of letters from
the beginning of a person’s last
name

c Users whose last names begin with C
c * Users whose first names begin with C
c h Users with the initials c h
gr:* All groups
res:* All resources

Notes on Searching

The search tool will only look for other people at CSU who are using the CST
Calendar.  It does not search the CSU Directory (LDAP server).  To search by
department, type criteria in the Org Unit 1 box.

[Note:  the department name or postal address you type should be the same as listed
in the CSU LDAP Directory Service which is accessible from the CSU Home Page.
To see that list, choose Browse Organizational Units from the CSU Directory
Page to find the Department name.  For instance, to find all those in Academic
Computing, the correct criteria statement entered in Org Unit 1 would be "Acad
Computing".]

All fields are searchable.  If you enter criteria in more than one field, the criteria
will be treated as an "and" statement.

You can also search for resources by their short name.  The departmental calendar
coordinator determines the short name.
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Scheduling Repetitive Meetings
To schedule a meeting that will recur on a regular basis, from the New Meeting
dialog box, click on the Repeating tab.  After you have selected the date, time, start
and end dates, click on the List Dates tab.  This will place all the dates within the
specified time frame in a list.  If you wish to delete any of the scheduled dates
during that period, select the date(s) and click Delete. [Note:  The approximate
number of repeating dates you can create is 55.]

Inviting Others to Attend
You will only be able to see free times on another person’s calendar if the owner of
that calendar has granted you Access Rights to do so.  This must be done by the
person whose free/busy times you wish to view, using his or her own calendar.  If
they have not granted you any specific Access Rights then you will only be able to
invite them to a meeting.  You will not be able to see if there are schedule conflicts
nor will the Calendar be able to suggest an open date/time.  If you do have viewing
rights then you could check for conflicts and receive suggestions regarding open
dates/times.

Viewing Others’ Agendas
By default, anyone can open your agenda.  However, unless you have specifically
assigned Access Rights to individuals or changed the default Viewing Rights (see
section on Access Rights below), anyone opening your agenda will see it as blank.
They will not be able to view your free/busy times and consequently will not be able
to be able to take advantage of the Calendar capabilities to detect conflicts and
suggest free times to meet.  If you wish to take full advantage of these scheduling
features, you will need to change Viewing Rights for the Default User (anyone
with a CST calendar) or for specified individuals.  (Note:  if you open another’s
agenda and they have a meeting scheduled that you are also invited to, you will be

You must click on
the List Dates
button  to complete
the scheduling
process.

Select a date from
the list below and
click Delete to
clear a date.
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able to see the full details of that meeting, regardless of the Access Rights assigned to
you.)

You cannot see another person’s In-Tray unless you have been assigned as their
Designate and have their Agenda open.

Viewing Multiple Agendas
You can view multiple agendas side by side to select an appropriate meeting time.
You can either add individuals to the view or if you have already made a group (see
section on Creating and Managing Groups below) you can view the agendas for
each of the group members.  To simultaneously view more than one agenda select
File, Open Agenda, Group Agenda from the menu or click the Group Agenda
button on the toolbar.  Select and add the names of
individuals or groups whose agendas you wish to view.

The left column will show the Combined busy/free times of all agendas displayed.
To schedule a meeting to include all those displaying calendars, select a time with
your mouse in the Combined column and then double click to open the New
Meeting dialog box.

Edit, Duplicate, Reschedule, or Delete Meetings
To edit an existing meeting, simply double click the item to edit.  This will open the
Edit Entry dialog box.  To duplicate or reschedule a meeting, click the agenda item
to select it, then choose Duplicate Meeting or Reschedule Meeting from the
Edit menu.  To delete a meeting, select the item and press the Del key or choose
Delete Meeting from the Edit menu.  [Note:  you cannot delete a meeting from your
agenda if you did not initiate it.]  You can also alter a meetings start or end time by
selecting the item and dragging the frame of the item to the desired time.  Move a
meeting by selecting and dragging the entire block of time.

Day Events & Daily Notes
Day Events are items that run for an entire day but do not block out time in your
Agenda.  Events appear in the Notes section of the day and week view.  Daily notes
function in the same manner.  The only difference is the icon that appears next to a
daily note.

Tasks
You can schedule tasks that need to be performed.  You may
include information such as due date/time, start date/time.  You
can also track the status of a task and mark them as completed.
To create a new task, select Edit, New Tasks.  An item on your
task may be marked as completed by clicking the icon to the left
of the task.  To view a list of tasks, click on the Open Tasks
button.
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Preferences
Each menu item listed under Options will display a series of dialog boxes in which
you may change some of the default settings of your calendar. Note that you may
not see a change take effect until you exit and restart Calendar.
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Agenda
Two tabs are active in this window, Display and Notification.  Use Display
options to set start and end times for the first and last time slots of your Day/Week
views.  You can choose the desired time interval (default is ½ hour), as well as other
color and display options for your agenda.  The Notification tab lets you determine
how you will be notified of upcoming events, whether others can send you e-mail
notification and if you would like to send e-mail to users you invite to events.

In-Tray
Use this option to change the length of time that items you have sent, accepted, or
refused will be displayed.

Scheduling
Scheduling lets you set the time frame in which to search for available meeting
times when using its Suggest a Date/Time function.  You can set different times for
each day or apply a given time frame to all days of the week at once.

Entry Defaults
This controls default reminders for meetings, tasks, notes, and events.  [Note:  you
can control reminders individually for an item by going through the Edit, New
menu.]

General
This is used to change formats for dates and to select another time zone.  You can
also specify the e-mail client to be used.

Off-line
If you find it necessary to download your agenda information and work off-line (not
connected to the CST server), then you can modify your options through this dialog
box.  You can choose where to store the local agenda and select reconciliation
options to properly "sync" the information when you upload it to the server.

Palmtop
Palmtop software is available from the Software Cellar and must be purchased
separately.  For more information contact the Software Cellar located in the
basement of the Weber building.

User Information
This information cannot be changed by the user but, rather, is kept current by
Academic Computing & Networking Services.

Reminders
To change the reminder for a single event, double click the agenda item and choose
the Reminders tab from the New Meeting dialog box. To change the default
reminder (or turn it off) for all events, from the main menu choose Options, Entry
Defaults.
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Access Rights
Access rights are privacy controls that allow you to limit the kinds of entries other
users can see in your Agenda.  Choose Access Rights from the Options menu.
The four tabs that appear are Designate, Viewing, Viewing tasks, and
Scheduling.  By default, no access to another user’s calendar is permitted.
Therefore, no one else can see any information in your calendar, unless you
specifically give that person permission to do so.

View Entries: allows others to view time, location, title and other information
about an entry.
View Times Only:  others can only view the busy/free time.

Designate
A designate is one that you allow to work in your agenda.  You can assign various
levels of access by clicking on the Designate tab and setting the desired options.

Creating and Managing Groups
If you frequently schedule meetings with a recurring group of people, you may want
to create a group list of those individuals.  Once a group is created, meetings can be
scheduled by referencing the group rather than each individual.

To create or edit groups, select Directory, Manage Groups.  Choose a name for
the group and place persons in the group by searching for them or typing their
name in the Members box.  Use the checkmark icon to add names to your list.

There are two kinds of groups you can create:  private and members only groups.
Private groups are only available to the group owner (creator of the group).
Members only groups may be used by anyone who is a part of the group.

You must de-select both boxes
before you can edit the viewing
rights for the entries listed above.
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Web Calendar Client
Calendar has a web interface accessible from any computer with an Internet
connection.  To use the Web to access your calendar, go to the following URL:
https://www.colostate.edu/cgi-bin/ctime/login.cgi  Or you can access the web
interface from the ACNS Calendar information page at
http://www.colostate.edu/acns/calendar/

You can use most of the features of the CST client software through the Web.
(Exception:  you cannot open an agenda on the Web as a designate.)  When you
make a change using the Web interface or your local calendar the changes are
immediately reflected in the other.  On-line help is available by clicking the help
button.

[Note:  Due to security settings that CSU has implemented on the server, on-line Help
is only available from the main page on Loma.  If you try to go to Help from any
other page of the CST Web Interface, you will not be able to link to it.]

Working Off-Line
A user can download an agenda to a local machine and work on it away from a
network connection.  When finished, the user can upload the file to the server.  Any
conflicts between the two calendars may be resolved through Reconciliation
options (see section on Preferences above).  To download your agenda to a local
file, choose Download to Local File from the File menu.  When you are finished
working off-line, upload the data to the server by choosing File, Upload from
Local File.

Printing
There are a variety of formats including Avery,
Day Timer, Franklin, etc. in which you can
print your calendar.  To print, go to Print on
the File menu.  Choose the style from the drop
down list and also the period of time (day,
month, year) you wish to print.  To preview
before printing, select Preview.

You can also print information for a specific
event.  Select the entry and choose Print
Selected Entry from the File menu.  If Tasks
are linked to the meeting, those Tasks will be
included in the printout.
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Attachments
You can attach a document to an event.  However, it can be no larger than 100 kb
and there can be only one attachment per event.  [Note:  you may want to consider
attaching a document to the e-mail notification rather than to the event notification.]
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Address Book
The Address Book in CST allows you to organize information for business and
personal contacts.  Aside from storing names, addresses, phone numbers, etc., it will
also store important dates for a person (e.g., birthday, anniversary) and enter that
information at the  appropriate date in your agenda as an note or event.  Also, if you
use a Palm device and synchronize that with your CST calendar, the Address Books
will be synced as well.   [Note:  the Address Book is saved locally on your PC.  You
may want to back it up periodically if you use it frequently.  It is one of the 4 XTM*.*
files in the default directory.]

Default Directory
When you open CST on your machine, the program will select a directory in which
to store four files.  These four files (all beginning with XTM) contain your profile
and address book information.

If you wish to access your calendar from a computer other than your own, it is
recommended that you use the Web interface.  If you choose to use the local CST
client on a machine other than your
own, a Different Local Storage
dialog box will display and indicate
that the current profile is owned by
whomever the previous CST user was
on that machine.  You then have two
choices.  Cancel which will exit CST
or Select another location.
Choosing another location means you will need to type in a new path for the local
files, or select another path using Browse.
[Note:  the directory does not have to exist; CST will make a new directory if you
specify a directory name that does not currently exist.]

If you select another location and use the calendar on that machine, the next person
to use Calendar from there will have to go through the same procedure.

Import/Export
The Import and Export utilities allow you to transfer data in a palmtop or text file
format.  To use these, choose either Import or Export from the File menu.  Select
the desired format from the drop down list and then follow the instructions in the
dialog boxes that appear.

Help
A comprehensive CST manual (135 pages) may be viewed or downloaded as PDF
from the ACNS web page at http://www.colostate.edu/acns/calendar/userguide.pdf.


